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Welcome to LINK training 

Today you will learn to use the LINK client recording system.  Your trainer will discuss 
course objectives and timetable with you, but typically the course takes 3 hours and 
goes as follows: 

 

1 Overview 

 What is LINK? What is it used for? 

2 Sharing and Protecting Data 

 How data is shared. 
How data is protected. 
Obtaining client consent. 

3 Finding a Client 

 Effective searching. 

4 Entering a New Client 

 Recording client consent & details. 

 Tea & coffee break 

 Recording, filtering & sorting actions. 

5 Printing Client Information 

 Printing client information. 

6 Passwords 

 The role of passwords.  
Changing your password. 

7 Practise and Final Questions 

 Course evaluation 
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What is LINK? 

LINK is a Web based client recording system.  It was developed in Dublin in 2001 by the 
Homeless Agency, Resource Information Service and homeless service providers.  
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How you might use LINK:  

Example 1 : 

We encouraged one of our clients to join a drug detox programme.  Then he 
disappeared and we wondered what happened to him.  We looked up his record and 
saw that he had gone to Dublin Simon Detox.  The name of his project worker was there 
so we could ring and see how things were going. 

Example 2: 

When I check my client's details in LINK I can find out what my colleagues did in a 
previous shift. This brings me up to speed right away. 
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What data can you record? 

Client Details  

First Name & Surname  

Date of Birth 

Age 

Gender 

Nickname  

PPSN 

Client ID 

Family Status 

Local Authority Area 

Homeless Status 

Have You Ever Slept Rough? 

If So, How Long 

Contact At Other Service 

Housing Register 

Homeless Register 

Homeless Register Application Date 

Date of First Homelessness 

First Experience of Homelessness? 

How Long Homeless 

Medical Card Details 

GP Contact Details 

Physical Disability 

Training 

Have You Any Literacy Difficulties? 

Are You Interested In Training? If Yes, What Kind? 

Education 

1st-2nd-3rd Causes/Risk Of Homelessness 

(LINK also records the name and agency of person 
entering the client) 

 

Actions & Outcomes 

Category (Type of Action) 

Action/Outcome 

Date of Action 

Notes (shared with all LINK users) 

Private Notes (shared with staff of own agency) 

 

Client Profile Form  

Ethnic Origin  

Citizenship 

Native Language 

Next of Kin 

Children Living Arrangements 

Main Source Of Income 
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How is client data shared? 

 

Client Details 

Information about the 
client 

Actions/Outcomes 

Actions done by an agency or the 
client  

 

Client Profile Form 

Information about the 
client 

All LINK users can 
read and edit these 
details 

All LINK users can read actions  

Only the agency that enters an 
action can edit or delete it 

"Private Notes" and actions 
created under the "Subsidiary" 
category are an exception - only 
the agency that records this 
information can read it. 

Only the agency that 
creates a form can edit 
and read it 

Each agency can 
create a form for a 
particular client 

The Homeless Agency can read all of the above. 
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How is client data protected? 

 

 

1 
Consent 

 Clients must give consent if more than name, date of birth & gender are recorded. 
They can refuse or withdraw consent.  
They can view their information or request a printout. 
 

2 Banking Level Security 

 LINK has the same level of security as a bank. 
It is more secure than e-mail or Microsoft Word documents.  
 

3 Restricted Access 

 Only homeless service providers & the Homeless Agency have access. 
Access is controlled by password. 
You are logged out after 30 minutes of inactivity. 
Passwords: 
- only last ninety days. 
- are cancelled when an employee moves on. 
- lock after 3 unsuccessful login attempts (similar to debit card pin security).  
 

4 Accountability 

 Each LINK user is responsible for his/her own data. 
Clients and LINK users can ask for incorrect or inappropriate data to be corrected. 
 

5 Awareness 

 Agencies must register with the Data Protection Commissioner.  
LINK users are trained to understand their responsibilities. 
 

6 
Participation 

 Dublin LINK User Group discusses data sharing and protection issues. 
Each organisation that uses LINK can send a representative. 
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Who does what? 

Project worker 

� Enters meaningful, accurate information  

� Discusses consent with client 

� Changes own password regularly 

� Shares password with no one 

Project leader 

� Ensures that project workers receive adequate training 

� Manages passwords for own agency 

� Ensures that data is accurate and protected 

� Runs reports for own agency 

Homeless Agency 

� Maintains & manages LINK 

� Provides training & supports users 

� Issues passwords 

� Processes requests for information 

� Runs reports 

Dublin LINK Users Group 

� Discusses LINK usage, data protection and technical issues 

� Proposes improvements 
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Getting started 

Following are the instructions for opening LINK on computers running the 'Internet 
Explorer' Web browser.  If your organisation uses a different set up, some steps may be 
slightly different -- if necessary, your team leader can help you. 

� Click Start  

� Click Internet Explorer   

TRAINER TIP    LINK cannot be found through Google as it is not on the World Wide 

Web, it is private. Trainees should therefore type the LINK web address into the Internet 

Explorer Address box.   

COURSE SET-UP    Make sure the web-browser Address box is visible on each 

computer.  If it is not, and you are using Internet Explorer, click View > Toolbars > 

Address Bar to display it.   

� In the Address box, enter https://dublin.linksystem.org.uk   

� Click Go or press Return  

� Enter your username: 

username:  

 

� Click Login  

� Enter your password: 

password:  

 

� You will be asked one of the following security questions:   

date of birth: 010101 

mother’s maiden name: smith 

 

� The LINK Welcome screen appears.  Your fictitious agency for today is:  

agency: Accommodation Service Providers  

 

You have now logged on to the LINK Training Website.  All of the information on this 
site is fictitious and may not be realistic.  
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Tips for logging on 

� Do not use slashes when you are entering a birth date to open LINK.  Use the 
format 010101, not 01/01/01.  (The opposite applies when entering dates within 
LINK -- there you should use slashes, and 4 digits for the year). 

� Be careful to enter the username and password EXACTLY as given to you in this 
manual.  This means not using a capital letter or space unless it is specified. 

Logging on quickly with Favorites 

On your first visit to the LINK website, you can "save the website to Favorites".  Then, 
on future visits you can simply pick LINK from the Favorites menu to open the site.  

To save a website to Favorites:  

� Go to the website 

� Click Favorites  (on bar at the top of the screen) 

� Click Add to Favorites  

� Click OK 

Welcome screen 

� See your fictitious name at the top left (under “You are logged in as:”)  

� This list is called Current/Default Clients  - it displays clients currently admitted 
to your agency (but not yet departed) 

EXTRA KNOWLEDGE     To be precise, the Current/Default Clients list displays all 

clients for whom the agency has registered an admission action but no departure action. 

 

LINK menu 
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Finding a client 

If you have a Client ID, you know that the person is already in LINK because this is a 
LINK number.  To find his/her details, do the following: 

� Click Find/Add on the LINK Menu  

� Enter the Client ID 

� Click Find button  

If you do not have a Client ID, do the following: 

� Click Find/Add on the LINK Menu  

� You need to enter some information (called ‘search criteria’) in order to find a 
client record.   

There are many possible ways to search.  For example, you could search using 
just the PPS number, a first name AND last name, or a date of birth AND/OR last 
name. 

� Click Find button  

 

PRACTICE EXERCISE: Finding a client 

Try finding a record for Timothy Beckham. 

 

Did you find it?   

_____________________________________________________ 

 

What search criteria did you use?  

_____________________________________________________ 

_____________________________________________________ 

_____________________________________________________ 

_____________________________________________________ 

 



How to use the LINK client recording system © Homeless Agency Sept 2007 13

 

PRACTICE EXERCISE: Effective searching  

Joe Soap's PPS number is 1234567X, his date of birth is 01/12/1954,  
and his nickname is Rabbit. Try finding his record in each of the following 
ways. Which of these are good methods?  Which are not and why?  

   

Firstname: Joe  

Surname: Soap    Good   Poor  

   

PPS number: 1234567X   Good   Poor  

   

Firstname: joseph  

Surname: soap    Good   Poor  

   

Firstname: Jo  

Surname: Soap    Good   Poor  

   

Firstname: Joe    Good   Poor  

   

Date of birth: 01/12/1954  

Surname: Soap     Good   Poor  

   

Nickname: Rabbit   Good   Poor  

   

Any name: Soap    Good   Poor  
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Tips for the Joe Soap exercise 

Joe Soap This may cause a problem if the person has previously 
been registered as ‘Joseph’.  You could search with 
‘Jo’ and ‘Soap’ instead. 

1234567X Using a PPS number is an excellent way of searching 
as every PPS number is unique. It has one drawback, 
however -- it won't work if nobody has previously 
entered the PPS number for this client. 

joseph soap This may cause a problem if the person has previously 
been registered as ‘Joe’.  You could search with ‘Jo’ 
and ‘Soap’ instead.  Note that it does not matter 
whether you use capital letters or not.  

Jo Soap This is a good way of searching. If you find more than 
one person, you will need to check the details of each. 

Joe This is not enough information as there may be 
hundreds of people called Joe. 

01/12/1954 AND Soap This is a good way of searching.  Remember, though, if 
the answer comes up negative, try another kind of 
search to be sure.  LINK accepts approximate dates of 
birth, and you can't be sure how existing information 
might been entered. 

Rabbit Sometimes people have quite a few names.  You may 
not know which name box to search in. To solve this 
problem, enter the name in the "Any name field" in the 
search window.  LINK will search for it in first name, 
nickname or surname boxes. 

 

EXTRA KNOWLEDGE    If you enter a search term in the Any Name field, LINK will 

find all records that match it in the First Name, Surname and Nickname/aka fields, but 

not in the Other Name field.  Note that the Other Name field appears on the Client 

Details screen, but not on the Find/Add a Client screen. 

TRAINER TIP     As in databases generally, duplicate records are a significant problem 

in LINK.  If a client is registered two or more times, the Link Coordinator at the 

Homeless Agency must reconcile them.  The two most common causes of this problem 

are: (1) clicking Add instead of Find in the Find/Add window, and (2) not checking to 

see if a client is already in LINK when entering him/her as a new client. 
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Adding a new client 

When you register a new client, it is very important to check to see if he/she is already 
in LINK before creating a new record.  If he/she is not, add the record as follows: 

TRAINER TIP    New database users may not appreciate the importance of checking to 

see if a client is already in LINK before creating a new record.  You might want to have a 

discussion about the problems created when duplicate records exist for a single 

individual. 

� Click Add Client  

� Fill in at least First Name,  Surname,  Date of Birth and Gender .  Note that you 
will need to enter the Date of Birth  even if you entered it while searching, as it 
will not be carried forward to this screen. 

� Click Save Details (The button is at the bottom of the screen.) 

Entering a Consent Action 

After you click Save Details,  LINK will bring you automatically to the Enter a New  
Action  screen, seen below.  IMPORTANT: You must confirm that you have the client’s 
consent before entering any further information. 
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� Click Consent  

TRAINER TIP    Failing to click 'Consent' and register a consent action is a common 

mistake made by new users.  It can confuse them because, without consent, LINK 

refuses to allow them to register further information. 

� Choose an Action/Outcome  

� Check that the Date given is the day that the client gave consent.  If not, enter 
the correct date. 

� Click Save (not Save and Continue ) 

� If necessary, click OK to confirm the date. 

� NOTE: if you do not record a written or verbal consent action, LINK will not allow 
you to enter any further information for the client. 

Entering Client Details 

� Click Client Details  

� Click Edit  (at the top of the screen) 

� Fill in the form.  Note that your name is recorded at the bottom of the form. 

� Click Save Details 

� If you want to double-check the information, click Review the Record . 

Entering a private Client Form 

� Click Client Forms  

� Click New (right hand side of screen) 

� Fill in the form. 

� Click Save 

� Click OK 

� If you wish to go back and change any information, click Current . 
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Entering an Admission Action 

� Click New 

� Make sure that Contact/Admission is selected 

� Choose an Action/Outcome 

� Check that the Date and Staff Contact  are correct 

� Click Save 

� If necessary, click OK to confirm the date 

Entering other actions 

TRAINER TIP    This is a good time to discuss the Action/Outcome dropdown list.  It is 

important that the trainees become very familiar with this list because most data entry 

involves using it.  

EXTRA KNOWLEDGE    You can use the Action/Outcome drop-down list in the Actions 

window as a filter.  For example, select 'Referral Actions' from this list if you want to see 

only those actions in the client history.  When you are finished, choose 'All Action Types' 

at the top of the drop-down list to see the complete history. 

TRAINER TIP    Trainees often pick an action from the drop-down list in the Actions 

window before clicking 'New' to create a new action.  They should not do this -- they 

should click 'New' first. 

After entering consent and admission actions, you can enter other actions: 

� Click New 

� Choose an action category 

� Choose an Action/Outcome 

� Check that the Date and Staff Contact  are correct 

� Notes  are visible to all LINK users - keep them to a minimum or enter none at all 

� Private Notes  are not visible to other homeless services - only record them if it is 
your organisation's policy to use this box for case notes 

TRAINER TIP    The 'Private Notes' box was added to LINK at the request of homeless 

services that wanted to use the system for their case notes.  It is worth stressing to 

trainees not to use this box unless their organisation has decided to use it for this 

purpose. 

� Click Save (not Save and Continue ) 

� If necessary, click OK to confirm the date. 



How to use the LINK client recording system © Homeless Agency Sept 2007 18

 

PRACTICE EXERCISE PART 1: Entering a New Client  

Try entering a client on to the database with the following information. 
Remember to check first to see if the person is already in the database. 
Assume that you have already spoken to her, and she has given written 
consent to put her details on the database.  

First name: Paula 

Surname: (assigned by trainer) 

Date of Birth: 24/03/1964 

Gender: Female 

Family Status: Single with children 

Homeless Status: Transitional accommodation 

Local Authority Area: Dublin City Council 

Contact at Other Services: Social worker 

Housing Register: Dublin City Council 

Homeless Register: Dublin City Council 

Application Date: 01/04/2005 

First Experience of Homelessness: Yes 

Date of First Experience: 14/01/2005 

Physical Disability: Yes 

 

You can come back later and add any information that you do not know 
when first creating a client record. 

 

(parts 2 and 3 of this exercise continue on the next page) 
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(exercise continues from the previous page) 

 

PRACTICE EXERCISE PART 2: Entering a Client Profile  Form 

Now that you've made Paula a client details form, you need to make a 
private form using the following information.  

Citizenship: Irish 

Ethnic Origin: White - Irish 

Children Living Arrangements: Some with client, some in care 

Main Source of Income: Lone parents 

 

PRACTICE EXERCISE PART 3: Entering Actions 

Enter the following actions that you have carried out on Paula's behalf.  

First Action  

Category: Contact/Admission  

Action/Outcome:  Client interviewed 

Date:  (this day last week) 

Notes:  None                                       

Second Action  

Category: Care and case management  

Action/Outcome: Care plan agreed 

Date: (today's date) 

Notes: None 

Enter a few more actions of your own choosing until you feel comfortable 
with this area of the database. Remember that this is where you will be 
doing most of your data entry. 
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When you have finished the above exercise, do the following exercises either in training 
or when you return to the office. 

 

PRACTICE EXERCISE: Retrieving information  

Find the Timothy Beckham record in LINK.  

Where did he last stay? 

_____________________________________________________ 

How old is he? 

_____________________________________________________ 

 

 

 

PRACTICE EXERCISE: Entering a New Client  

Enter a new client with the following information. Assume that he has 
given written consent to put his details on the database.  

First name: Michael 

Surname: (make up a surname) 

Date of Birth: 24/03/1980 

Gender: Male 

Family Status: Single only 

Homeless Status: Street 

Local Authority Area: Dublin City Council 

Contact at Other Services: Probation officer 

 

(practice exercise continues on next page) 
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(practice exercise continues from previous page) 

 

First Experience of Homelessness: No 

Date of First Experience: 14/01/2001 

Cause of Homelessness: Discharge from prison 

Physical Disability: Yes 

 

Now that you've made Michael a client details form, you need to make a 
private form using the following information.  

Citizenship: Irish 

Ethnic Origin: White - Irish 

Children Living Arrangements: Some with client, some in care 

Main Source of Income: Disability 

 

Enter the following actions that you have carried out on Michael's behalf.  

First Action 

Category: Contact/Admission  

Action/Outcome:  Client interviewed 

Date:  (this day last week) 

Second Action  

Category: Needs assessment 

Action/Outcome: Independent Living Skills 
 Assessment 

Date: (today's date) 
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Printing client information 

To print the details about an individual, first find your client using Find/Add . He/she 
should appear something like this, where three orange buttons are visible:  

 

 
TRAINER TIP    Printers are not always available during training.  In this case, ask 

trainees to choose Print Preview from the File menu instead of Print.  When they have 

done this, they close this window by choosing either the Close button or the X in the top 

right corner. 

Printing Client Details 

� Click C button (to right of name) 

� Choose Print from the File menu (on bar at the top of the screen) 

� Choose the number of copies and click Print  again 

� Click Back  (on bar at the top of the screen) 

Printing Client Actions 

� Click A button (to right of name) 

� Note that All Listed Projects is selected.  You can modify this if you want to see 
actions carried out by only certain agencies. To pick more than one agency, hold 
down the Ctrl  key on your keyboard and click on the name of each one 

� Note the Start Date  and End Date .  You can modify these if you want to print the 
actions carried out over a longer period of time. 

EXTRA KNOWLEDGE     If trainees want to find out all actions ever entered for a client, 

they can put 01/01/2000 as the start date.  This is because LINK has only been in 

operation since 2001.  

� Click Run Report 

� Choose Print from the File menu (on bar at the top of the screen) 

� Choose the number of copies and click Print  again 

� Click Back  twice (on bar at the top of the screen) 
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Printing a Client Profile Form 

� Click F button (to right of name) 

� Select the date of the Client Profile Form  from the dropdown list 

� Choose Print from the File menu (on bar at the top of the screen) 

� Choose the number of copies and click Print  again 

� Click Back  (on bar at the top of the screen) 

 

PRACTICE EXERCISE – Printing Actions  

Find Timothy Beckham in LINK. 

Print out all the actions entered by All Listed Projects since LINK began 
in 2001. 

Print out only the actions entered by the Information and Advice 
Services. 

Print out only the actions entered by the Information and Advice Services 
and by the Settlement Services. 

 

Passwords 
� LINK passwords have 7-15 characters 

� A password must consist of only numbers and letters, with a minimum of 2 
numbers and 5 letters 

� Passwords expire every 90 days 

� LINK will lock you out of the system after 30 minutes of inactivity.  You must click 
a button during this time; just entering text will not be sufficient.   

� Your password will be disabled after three unsuccessful login attempts.  If this 
happens, contact your project leader who will issue you with a new password.  If 
you are a project leader, contact the LINK Coordinator at the Homeless Agency. 
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Responsibilities regarding passwords 

� Never tell anybody your password 

� Don’t share client information with anyone not authorised to use LINK 

� Log out of LINK before leaving 

� Print only what you need & store client printouts in a secure filing system 

Changing a password 

TRAINER TIP    It is time-consuming for a Project Leader (or, for Project Leader 

passwords, the Homeless Agency) to continually have to re-set expired passwords.  It is 

essential to emphasise to trainees the importance of keeping their password up to date.  

You may like to suggest that they should keep a reminder somewhere (like a diary) of 

when their password needs to be renewed. 

� Click Change Password  (left hand side of screen) 

� Enter your Current Password  

� Enter your New Password .  Your new password must be different from your 
current password. 

� Enter your New Password (again)  

� Click Change Password  

 

This is the end of the course. Good luck and please be sure to fill out your evaluation 
form before you leave. 

Also, remember to close LINK as follows: 

Logging off 

� Click Logout  (left hand side of screen) 

� Close Internet Explorer 
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Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


